
legutóbbi cikkemben (Linuxvilág, 2003. március) azt
mutattam be, hogyan távolíthatjuk el villanóval ké-
szült pillanatfelvételeinkrõl a Gimp (The GNU Image

Manipulation Program, azaz GNU képszerkesztõ program)
segítségével a bosszantó vörösszem-hatást. Mostani írásomban
a Gimp újabb hasznos fogását ismertetem fényképeink javítá-
sára: a digitális átmeneti szûrõt (ND-filter) azoknak a képeknek
a rendbehozatalára használhatjuk, amelyek hibáját a túl nagy
kontrasztú jelenetek fényképezése okozza.
Az emberi szem igen figyelemre méltó képességekkel bíró
„képérzékelõ” berendezés. Képes olyan képek érzékelésére,
amelyek igen széles dinamikatartománnyal (fényerõsség-kü-
lönbséggel) rendelkeznek, és alkalmas a részletek megkülön-
böztetésére mind a világos, mind pedig a halványabb, árnyé-
kos részeken belül. A fényképezésben a fényességet gyakran
a rekesznyílással mérik, ahol minden egyes érték a fény felét,
illetve kétszeresét jelenti a szomszédos értéknek. Az emberi
szem képes megkülönböztetni egy olyan látvány képrészleteit,
amelyben a fényesség a legsötétebb és legvilágosabb rész
között 14 ilyen egység. A filmek és a digitális fényérzékelõk
messze nem ilyen ügyesek. A diapozitív jellemzõen 5–6 egysé-
get kezel. Az alsó határnál sötétebb részek teljesen sötétek
lesznek, míg a felsõ határértéknél világosabb részletek fehér
színû résszé olvadnak össze. A negatív filmek a 9–10 egységük-
kel egy kicsit jobban teljesítenek, és néhány csúcskategóriás
digitális fényképezõgép (DSLR) egy leheletnyivel még ennél
is többre képes. A digitális fényképezõgépek 6–9 egység kezelé-
sével ebbõl a szempontból a képfelfogó eszközök versenyének
hátsó mezõnyében foglalnak helyet; a pillanatnyi érték függ a
digitális rögzítési eljárás színmélységétõl, az érzékelõ méretétõl
és néhány más tényezõtõl.
Képzettebb fotósok, ismervén
a gépük korlátozott felbontó-
képességét, különbözõ eszkö-
zökkel próbálják meg csökken-
teni a fényképezendõ jelenet
dinamikatartományát. Tehetik
ezt az árnyékos részek világo-
sításával (vaku, világítás, ref-
lektor használatával) vagy
a túl fényes részek sötétítésé-
vel, például olyan különleges
szûrõkkel, mint amilyenek az
átmeneti szûrõk. Az 1. képen

egy ilyen szûrõ látható. Ez egy olyan tartozék, amit az objektív
elejére rögzíthetünk, s egy teljesen átlátszó és egy sötétszürke
tartománnyal rendelkezik, ezeket folyamatos átmenet választja
el egymástól. A szûrõ sötét része a szûrõ erõsségétõl függõen 1,
2 vagy még több egységgel csökkenti az átengedett fény
erõsségét. Amikor a fényképezõgépet egy nagykontrasztú kép
fotózására készítjük elõ (például egy naplementére), akkor a
szûrõt úgy kell beállítani, hogy a sötét része fedje le a kép
világos tartományát (például az eget), az átlátszó rész pedig

a kép többi részét (például a látóhatár alatti részt). Ezután a
fotós a sötétebb rész alapján megmérheti a megvilágítást.
Amennyiben a szûrõ elhelyezése megfelelõ volt, a fénymérõ is
helyes értéket mért – és a fényképész nem mulasztotta el
lekopogni a várt eredményt, valamint egy kis imát is
elmondott, miközben egy csipetnyi sót a bal válla fölött maga
mögé szórt – a teljes kép megfelelõ megvilágítású lesz.

A legtöbb hétköznapi fotós nem foglalkozik azzal, hogy átme-
neti szûrõt cipeljen magával, és ilyen esetekben azt használja.
Ilyenkor az egyetlen mûködõ megoldás az, ha engedményt
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A fényképek kontrasztjának javítása Gimppel
Hogyan korrigáljuk fényképeink túl sötét tartományait anélkül, 
hogy a világos részek kifakulnának?
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teszünk. A legtöbb önmûködõ rendszer az arany középutat
választja, és hagyja elveszni a fényességtartomány két szélén
lévõ részleteket. Ha úgy döntünk, hogy kézzel állítjuk be az
expozíciót, követhetjük a diát használó fotósok gyakorta emle-
getett ökölszabályát: a kép szempontjából fontos világos részre
állítsuk be az értékeket. Sokszor utólag még helyre lehet állítani
a sötét tartományok részleteit, de ha a világos rész kiégett,
onnan már nem tudunk megmenteni semmit. Azt se feledjük,
hogy a szabály a fontos részt említi. Ha naplementét fényké-
pezünk, bizonyára meg szeretnénk õrizni a napfény által bera-
gyogott felhõk mintázatát és részleteit, de ha a képünk egy
mezõn álló jávorszarvast ábrázolna napnyugtakor, akkor eset-
leg a szarvas prémjének a részletei a fontosabbak, a felhõk
pedig legyenek olyanok, ahogy éppen sikerül.
Bár az ilyen megvilágítású képek összes részlete nem állítható
vissza, mégis gyakori, hogy egy kis trükkel a fényes és sötét
tartományokban megbúvó képrészletek jelentõs része meg-
menthetõ. A hagyományos folyadékos képelõhívó eljárás ezt
a folyamatot fényvisszatartásnak és kiégetésnek (dodging and
burning) nevezi. Amikor a negatívról papírképet készítünk,
a papír egy része jobban vagy kevésbé kerül megvilágításra a
többinél, megtartva a fényes részleteket vagy elõhozva a sötét
tartományok különbségeit. Ezek a fortélyok azonban eddig
csak a sötétkamra szerelmesei számára voltak hozzáférhetõk.
Most a Gimp segítségével bárki megteheti ugyanezt, mégpedig
sokkal egyszerûbben. Ezt az alábbi példán keresztül szeretném
bemutatni: a 2. képen a utahi naplemente látható a Gimp egyik
ablakába töltve. Követve a bölcsek szavát, a képet a felhõkre
és a fényes sziklákra állítottam be, és hagytam, hogy az elõtér
sötét maradjon. A LAB-felbontó bõvítmény segítségével ezt az
RGB-képet felbonthatom a LAB alkotóelemeire. Ezek közül az
L-csatorna a képen elõforduló összes fényességértéket (lumi-
nance) hordozza. Ahogy az a 3. képen is látható, a kép elõteré-
ben lévõ fák jelentõsen részletgazdagságok, amit a kép eredeti
nézete szinte teljesen elrejt a szemünk elõl. De hogyan tudnám
úgy elõcsalogatni ezeket a részleteket, hogy közben a sziklák és
felhõk gyönyörû színei és részletgazdagsága ne változzék?
Ennek a sötét tartománynak a megmentése kicsit olyan, mintha
az átmeneti szûrõ használatának a digitális megfelelõjérõl lenne
szó. Ugyanannak a képnek két változatát egyesítem, ahol az
egyes változatok a sötét, illetve világos részre lettek egyszerûsít-
ve. Mivel ez a módszer a Gimp réteg- és rétegmaszkkezelõ képes-
ségét aknázza ki, elõször ezek mûködését kell megértenünk. 

Rétegek és rétegmaszkok
A Gimpben kezelt összes kép egy vagy több réteget alkothat.
Egy kép elsõ betöltõdésekor az alapértelmezett háttérréteget
foglalja el, ahogy a 4. képen is látható. További rétegeket hozha-
tunk létre a háttérréteg fölé. Ezek a felsõbb rétegek is tetszõ-
leges képet tartalmazhatnak. Gyakori eset, hogy itt ugyanan-
nak a képnek különbözõ változatait akarjuk tárolni. Ezt a
legkönnyebben úgy érhetjük el, hogy másolatot készítünk az
eredeti képrõl, mint az 5. képen is látszik, ahol épp a háttérré-
teget kettõzöm meg. Minden rétegen a többitõl függetlenül
hajthatunk végre mûveleteket. A 6. képen az látható, amint
éppen a felsõ rétegen hajtok végre szintbeállítást a kép világo-
sítása érdekében.
Az egyes rétegek különbözõ módokon egyesíthetõk az eredõ
kép létrehozásához, hasonlóan ahhoz, mintha a felsõ rétegen
keresztül néznénk az alsót. Az egyik lehetõség, hogy a felsõ
rétegek vagy egy részük átlátszóságát változtatjuk. Egy réteg
átlátszósága a teljesen átlátszótól (0%) az átláthatatlanig terjed
(100%), és a kettõ között tetszõleges értéket állíthatunk be. Arra

is lehetõségünk nyílik, hogy a réteg egyes tartományai külön-
bözõ átlátszóságértékkel rendelkezzenek. Ezt ismét többféle
módon érhetjük el, de a legrugalmasabb módszer a rétegmaszk
használata. Rétegmaszkot bármikor hozzáadhatunk a réteghez,
ami a réteg tulajdonsága lesz. Ez a réteggel azonos méretû
szürkeárnyalatos kép. A rétegmaszk a réteg átlátszóságát olyan
módon változtatja meg, hogy annak értéke minden képpont
esetén a maszk adott pixelének az értékével egyezik meg.
A maszk fekete pontja a réteg teljes átlátszóságát eredményezi
a megfelelõ ponton, míg a fehér teljes fedést eredményez. E két
szélsõ érték közötti értékek a megfelelõ átlátszósági százalék-
értéket rendelik a réteg adott pixeléhez.
És ezzel még csak a lehetõségek kezdeténél tartunk. A 7. képen

egy olyan rétegmaszk látható, ami jól használható  képünk
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felsõ rétegéhez. A maszk létrehozásakor egy olyan átmenettel
töltöttem fel, aminek a hatására a felsõ réteg átlátszósága a két
szélsõ érték között fokozatosan változik, ahogy a 8. képen lát-
ható. Végül a kép a 9. képen mutatott módon egyesíthetõ a ki-
menet számára.
A rétegmaszk csak egy, a rétegek számos lehetséges tulajdon-
sága közül. Más tulajdonságok – mint például a keverési
mód (blend mode) – azt határozzák meg, hogy az egyes réte-
gek milyen módon legyenek egyesítve az alattuk fekvõ réte-
gekkel. A rétegek mûködésének további vizsgálatába fektetett
energia bõven megtérül a Gimp képszerkesztõ lehetõségeinek
bõvülésében.

A részletek
Most, hogy felvérteztük magunkat a rétegek és maszkok ke-
zelésének képességével, vizsgáljuk meg közelebbrõl az eljárást.

A Gimp legtöbb menüpontját a kép ablakán végrehajtott jobb
egérkattintással érhetjük el. A következõkben ezt a mûveletet
JK-val rövidítem. Ha egy alkalmazandó Gimp-tevékenységet
szeretnék leírni, zárójelek közé tett menüpontsorozatot vagy
billentyûkombinációkat olvashatunk majd. Például egy kép
megnyitásakor a (JK>File>Open) formát használom, ami any-
nyit jelent, hogy a jobb egérgombbal kattintunk a kép ablakán,

kiválasztjuk a File menüpontot,
majd a megjelenõ menübõl az
Open-t. Ha célszerûbbnek tûnik
a billentyûkombinációs megol-
dás, listát közlök azokról a
billentyûkrõl, amiket meg kell
nyomnunk. Például a kép máso-
lására szolgáló (CTRL-C) jelen-
tése: nyomjuk le és tartsuk
nyomva a CONTROL billentyût,
majd nyomjuk meg a C-t.
Nyissuk meg a Layers (rétegek)
párbeszédablakot az eredeti
képen (CTRL-L). A párbeszéd-
ablakban kattintsunk a jobb
gombbal a háttérréteg nevén
(Background), és válasszuk a
Duplicate (megkettõz) paran-
csot, vagy nyomjuk meg a
10. képen bekarikázott gombot.
Kattintsunk kétszer a létreho-
zott rétegen, majd adjuk neki
az ND Filter (ND-szûrõ) nevet.
Ez a lépés nem feltétlenül szük-
séges, de felesleges kavarodás-
tól kímélhetjük meg magunkat
vele, így ha fél év múlva újra
megnyitjuk a lépet, tudni fog-
juk, hogy melyik réteg mit
tartalmaz, és mit hogyan csinál-
tunk. Pillanatnyilag a Layers

párbeszédablaknak a 10. képen látható képet kell mutatnia.
Még mindig ugyanebben a párbeszédablakban válasszuk ki
az ND Filter réteget. Váltsunk át a kép ablakába, és végezzük
el azokat a mûveleteket, amelyekkel a fényes vagy árnyékos
tartományok részletgazdagságát növelhetjük. Erre jól használ-
hatók a szintekkel (RC>Image>Colors>Levels), illetve a gör-
békkel (RC>Image>Colors>Curves) kapcsolatos mûveletek,
de a fényerõsség/kontraszt állítását (RC>Image>Colors>

Brightness and Contrast), a megvilágítottság javítóeszközeit
(dodge/burn) vagy bármi mást is használhatunk – amit
alkalmasnak tartunk rá.
Mivel a másolat rétegén dolgozunk, nem kell azzal törõdnünk,
hogy mi történik a kép jó felével, hagyjuk nyugodtan, hogy túl
sötét vagy világos legyen. Összpontosítsunk arra, hogy a javí-
tandó tartomány megfelelõ legyen. Ebben az esetben én a szin-
teket (Levels) módosítottam (a középsõ csúszkát a 11. képen lát-
ható módon egy kicsit balra mozgattam), ezzel világosítottam az
egész képet, míg az elõtér képe a kívánt módon meg nem jelent.
Ezen a ponton a 6. képen látható helyzetben kell lennünk:
látható a kivilágosított kép, ami elfedi az alatta lévõ eredetit.
A következõ feladatunk egy rétegmaszk létrehozása, ami fel-
fedi az alul lévõ kép felsõ részét. A Layers párbeszédablakban
a jobb gombbal kattintsunk az ND Filter rétegen, és válasszuk
ki az Add Layer Mask (rétegmaszk hozzáadása) menüpontot.
Az Add Mask Options (maszk beállítása) párbeszédablakon
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válasszuk a White (fehér) színt
(ez a teljes átlátszatlanság),
és kattintsunk az OK gombra.
Végül a Layers ablakon
kattintsunk a Background

réteg mögött lévõ szemre,
amivel a háttérkép láthatóságát
kapcsoljuk ki. Layers párbeszéd
ablakunknak ezen a ponton
a 12. képen látható állapotban
kell lennie, egy kis fehér réteg-
maszkikonnal az ND Filter

rétegikonja mögött.
Váltsunk át a Gimp fõ eszköz-
dobozának ablakára, és válasz-
szuk a 13. képen bekarikázott
színátmenetes kitöltés eszközt
(gradient fill tool). Menjünk
vissza a kép ablakára, és az egér-
rel húzzunk egy vonalat olyan
szögben és irányban, ahogyan a
felsõ és alsó réteget el szeretnénk
választani (a lenti réteg a vonal
kezdete, a fenti pedig a vége).
A húzott vonal hossza azt fogja
megadni, hogy milyen fokozatos,
illetve hirtelen lesz az átmenet az
elõálló képösszetételen. Egy kis
gyakorlást igényel, hogy ráérez-
zünk, de általában egy rövid vo-
násra van szükség az átmeneti sávon keresztül (ami például a
látóhatár lehet). Mivel a háttér láthatóságát kikapcsoltuk, az
eredmény azonnal láthatóvá válik, ahogy azt a 14. kép is mu-
tatja; a kép átmeneti sávon túli része el fog tûnni. Ha nem sike-
rült jó helyre rakni az osztóvonalat, az egérrel egyszerûen
húzzunk egy új vonást: az új átmenet azonnal megjelenik a
régi helyén. Ha nem világos a mozzanat, nézzünk a 7. képen
lévõ átmenetre. A Layers párbeszédablakon lévõ
rétegmaszkikonon meg kell jelennie a most létrehozott átmenet
kicsinyített másának. Emlékezzünk rá, hogy a színátmenetes
kitöltés a felsõ réteg átlátszóságát fogja befolyásolni. A fehér
nem átlátszó, a fekete teljesen az, a kettõ között lévõ színek
pedig valamilyen mértékû áttetszõséget jelentenek.
Ideje szemrevételeznünk munkánk eredményét: kattintsunk
a háttérréteg Background neve után lévõ szemre a Layers abla-
kon, visszakapcsolva ezzel a réteg láthatóságát. És íme – az egye-
sített képünk, aminek mindkét tartománya megfelelõen expo-
nált. Most kattintsunk az ND Filter réteg mögött lévõ szemre, és
kapcsolgassuk ki-be a digitális ND-szûrõ hatásának láthatóságát.
Nem rossz, ugye? A 15. kép a végsõ eredményt mutatja.
Ennek a megközelítési módnak az az igazi szépsége, hogy
eredeti képünk érintetlenül fekszik a háttérrétegen. A második
réteg világosított képe sem igényel valami hajszálpontos tarto-
mánykijelölést, hogy csak a megfelelõ részt érje a hatás, és
(ebben az esetben legalábbis) a rétegmaszk létrehozása is
könnyen végrehajthatónak bizonyult. A teljes rugalmasság
kedvéért a képet a Gimp saját xcf formátumában menthetjük,
ezáltal a teljes rétegszerkezet is megmarad. Lesz még rá lehetõ-
ségünk, hogy késõbb további módosításokat végezzünk a
képen, méghozzá abban a biztos tudatban, hogy az eredeti
kép sértetlen és könnyen hozzáférhetõ a háttérrétegen arra
az esetre, ha bármikor törölni szeretnénk a végrehajtott módo-
sításokat. Amikor készen vagyunk, a képet valamelyik nép-

szerû képformátumba (TIFF vagy JPEG) exportálhatjuk, és
ezzel a 9. képen látható módon fog megjelenni az eredmény.
A rétegmaszk mûködésének ismeretében elgondolkodhatunk
olyan eljárásokon, amelyekkel sokkal összetettebb átmenetek
is megvalósíthatók a fényes és árnyékos képrészek között
(például egy égnek meredõ sötét szikla esetén). A rétegmasz-
kon ugyanazokat a mûveleteket hajthatjuk végre, mint bármi-
lyen más szürkeárnyalatos képen, ezzel tetszõleges módon
keverhetjük a felsõ és alsó rétegek tartalmát.
Remélem, hasznosnak bizonyul a bemutatott eljárás, és sok
nyári napfényes felvételt sikerül megmenteni vele. Az egyik
talán éppen egy görögországi utazás emléke lesz…
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15. kép A végeredmény

14. kép Színátmenetes kitöltés alkalmazása

12. kép A háttérréteg
láthatóságának kikapcsolása

13. kép Kitöltés
színátmenettel
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